R8C 11/13 Application Model R8C11/13-FE-A19
|

Introduction:

This Demo discusses a complete application based on R8C11/13 microcontroller. The applica-
tion is based on a digital clock with the simple interaction. Four digits of seven segment LED
display are used to display the stop clock along with three switches for the operation.

Demo Hardware:

The hardware contains 4 digits of seven segment LED displays connected in the multiplexed

format. Three push button switches are connected to port lines to get Start, Stop and Clear

commands.

Port line Display Lines

POO BCD I/P A

PO1 BCDI/P B

P02 BCDI/PC

P03 BCD I/P D

P04 Digit Selection Control for digit 1
P05 Digit Selection Control for digit 2
P06 Digit Selection Control for digit 3
PO7 Digit Selection Control for digit 4
Port line Push Button Swicthes

P30 Start Switch

P31 Stop Switch

P32 Clear Switch
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R8C11/13-FE-A19

R8C 11/13 Application Model

Circuit Connection Using FE EADS:
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R8C 11/13 Application Model R8C11/13-FE-A19
|

Connections:

1. Connect port lines P00 to P03 to BCD inputs of seven segement display.
2. Connect port lines P04 to P07 to digit selection input of seven segment display.

3. Connect port lines P30 to P32 to three push button switches.

Functional Description:

In this module, a complete project for the 4 digit stop clock is provided. 4 digits of seven segment
display are used for displaying the seconds and 3 numbers of push button switches are used to
give Start, Stop and Clear commands. The seven segment display is used in multiplexed mode
with BCD input.

Timer X of the R8C Tiny is used to generate an interrupt at a rate of one milli second. In the timer
Xinterrupt service routine, the LED display is refreshed and the milli seconds are counted to get
one second delay for counting the seconds after the start command from the user.

Registers Used:

PDO - Port O Direction Register

PD3 - Port 3 Direction Register

TXMR - Timer X mode register

PREX- Prescaler X Register

TX - Timer X Register

TCSS- Timer count source setting register
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R8C 11/13 Application Model

R8C11/13-FE-A19

Port Pi Direction Register:

Symbal

PO
bf ES bS bd B3 b3 b1 b0 F\D1
PD3
PD4

Address Aftar resat
OOE21e 001s

OOE3 16

0016

O0ET18 0016
O0EA1G 0016

Bit symbaol

Eit nama

Function

R

e ——

1 POi_0

Part Pio direction bit

te--{ PO 1

Part Pit direction bit

--------- FDi_2

Part Piz direction bit

AN =75

Part Pi3 direction bit

R ——

Part Pid direction bit

SRR —

Part Pis direction bit

mmsmmmammme e e e POLG

Part Pie direction bit

| PR S —— T

Part Pit direction bit

R

0 Input mode

R

{Functions as an input port)
1 : Qutput mods

R

{Functions as an output port)

R

R

R

R

R

MNotes:

1. The PDO register must be writtan to by the next instruction after satting the PRCZ2 bitin the PRCR

register to “1" (write enabled).

2. Mothing is assignad to the PD2_4 to PD3 6 bits in the PO3 register.
When writing to the PD3_4 to PD3_6 bits, write “0" finput mode). When read, its content is

indetaminate.

3. Mothing is assignad to the P04 Oto PD4 4 P04 6 and PD4 7 bits in the PD4 register.
When writing to the PD4_0to PD4 4, PD4_G and PD4_ 7 bits, write “07 (input modea). When read,

its content is indeteminate.

PDO is set to H'FF to select all lines of port 0 (P00 to P0O7) as output lines to control the seven

segment display. The port 3 lines P30 to P32 are selected as input lines after the reset.

Timer X Mode Register:

Timer X mode register

b7 b3 b5 b4 b3 b2 b1 BO bl Address After reset

I I I I I I I I TEKR 08B 001s
EEEEERE ,
I v 1 Bitsymbaol BIt name Functon i
I I B . i bk
Pbbd Y oo ﬁ;‘:‘ﬁﬂf’f‘* 00 Timer mode or R
H i - = pukse pariod measurement mode
[ T T T 0 1: Pubke output meds
P P TAMOD 1 0: Event countar mode (=
L T T R 1 1: Puke width measurement mode
E i i E E — DEDG mhﬁ-himfmng Funclion varies with each operation mode =
T - TiS Timer X zount 0 Stepe counting B
Voo start flag 1: Starts counting
n n 1 n
N - TocnT | PRACHTR: Function varies depending on opsration mode | gy
i E i - select bit
E i i _________________ TEMOD2 | Dperation mode 0: Exceptin pulse pariod measurement mode R
; i select bit2 1: Pulsz period measuremant mods b
E (I TXEDG ?c:g';i;jgﬂzg Function waries depending on opsration mode. | gy
e ] TAUND | Timer X inder

fiow flag

Function varies depending on operation mode. | gy

MNotes:

1. The IR kit in the INT11C register may be set to “17 {intemupt requested) when the ROEDG kit is rewrittan.
Refer to the paragraph 19.2.5 “Changing Interrupt Factor™ in the Usage MNotes Reference Book.

Timer X mode register TXMR is loaded with H’00 to set the timer mode.
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R8C 11/13 Application Model R8C11/13-FE-A19
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Prescalar X Register

Frescaler X Register

|5 [t] Symbal Addrass After reset

| FREX COEC1E FF1&
i
E Mode Function Baitting range R
[— Timer mode Intermal count soures is countad

0016 to FFiE R

Pules output mode | Intarnal count souree is counted .
001E to FR16 R

Ewvent countar moda | Extarnally input pulses are counted 001G ta FF1G R
e v

Pulss width Pulse width of extamally input

measuramant mode | pulses i measursd 001& bo FF1G R
{Int=rnal count source is counted)

Pulse period Puke pericd of extemally input

measurement mode | pulses i measured 001E to FF1G RW

{Internal count source i counted)

The prescaler register PREX is loaded with 100 to divide the selected clock meant for the timer
X.

Timer X Register

Timer X Register

Lr Lo Sym bal Addrass Aftar reset
| | T Q080G FFie
i
i Function Satting range | FW
Undarflow of Prascaler X is counted 0016 to FF1G R

The timer X register TX loaded with 100 to generate an interrupt at 1 milli second rate.
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R8C 11/13 Application Model

Timer Count Source Setting Register.

Timer count source setting register

R8C11/13-FE-A19
. _______________________________________________________________________________________________________|

D7 B8 b5 B4 B3 b2 bi b0 Symbol Address After resat
[elaJ T T T T ] oss QORE1: s
Ell sgmbol Funchon R
THCHA Timer ¥ count source | 275° ,
sofect b oo R
o1 M=
..... THCKA 10 2 N
R
1112 '
-------- T KD Timar ¥ count souce :;III:;:: " =]
salact oit? 011 -
........... TYCK1 10 TRING =i
11 : Salects npul rom CHTR pin
______________ TZCKD Timer Zoounl sourcs =5 o
Por selact bt ao:n -
[ a1:1a —]
[ PO TZCKA 10 Salects Timer ¥ undemow o
=8
. 1112
1 n
T —— | resarved bi Must be sel o .
(BT -ba)

Halas:

1. Awold switching a count saurss, while a counter 1s In pragress. Timer counler musl b= slopped betore switching a count

BOLICE,

The data H'03 is moved to Timer Count Source Setting Register TCSS to select “f2” as source

clock for Timer X.

Software Description:

In the main loop, two types of operations are carried out according to the clock status. If the

clock is in active running condition, only stop swicth was enabled during switch scanning to

issue a stop command. In the active stop clock condition, clear command is disabled. When the

clock is stopped, the start and clear switches are enabled to get start and clear commands.

After the start command, the clock running variable is set to clock running state and after the

clear command, the variable holding the seconds count will be cleared to 0.

The files used in this module are listed below:

Files Description

R8C1113_FE_A19.C

The only file for this module, has
the processing function for the
stop clock, timer Xinterrupt
senvice routine and initialization
routines for seven segment
display, timer X etc.
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R8C 11/13 Application Model

R8C11/13-FE-A19
. _______________________________________________________________________________________________________|

The functions in the file R8C1113 _FE_A19.C and short descriptions are listed below:

Files Description

ProcessStopClock

Checks the Start, Stop and Clear switch status and
starts the stop clock or stops the stop clock or clears
the clock contents. Displays the counted seconds after
start command.

Inpu

ProcessTimer_X Int

Timer Xinterrupt senice routine. Here the seven segment

display was refreshed and the milli seconds are counted

to get one second delay. The seconds are counted after
the start of the stop clock.

InitializeTimerX

Timer Xis initialized to generate an interrupt at a rate of
one milli second.
Input: None.
Output : None.

InitializeSevenSegmentLED

This routine will initialize I/O lines used for seven
segment display, Timer X and variables used for
refreshing display.

Input: None.

Output : Non

Display4Digits

Displays the given 4 digit number on seven segment
display.
Input: 4 Digit number.
Output : None.

BCDIncrement

Increments the given 4 digit number by one in BCD
format and returns the same to called function.
Input: 4 Digit number.

Output : Incremented value of given nu

InitializeSevenSegmentLED

This routine will initialize I/O lines used for seven
segment display, Timer X and variables used for
refreshing display.

Input: None.

Output :

Display4Digits

Displays the given 4 digit number on seven segment
display.
Input: 4 Digit number.
Output : None.

BCDIncrement

Increments the given 4 digit number by one in BCD
format and returns the same to called function.
Input: 4 Digit number.

Output : Incremented value.
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R8C 11/13 Application Model R8C11/13-FE-A19
|

Program Flow:

For Main Loop

(s )
Y

1. Initialize Port 0 as
output port.

2. Initialize variables to 0.

3. Initialize Timer X to
generate an interrupt at
1 msec rate.

[
-

Y

Is there is any change Yes

in the time counter?

Display the new value of
time counter on LED

No

A

Y

Is the Clock is in Yes
Running State?

No Is the Stop button
Pressed?
Y
Is the Start Button Yes
Pressed?
Clear milli seconds count
variable and Start the Stop the Clock.
No stop clock.
< ]
Y

Is the Clear Button
Pressed?

Clear time count variable
and update display with
new value.

[
-

A

A
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R8C 11/13 Application Model R8C11/13-FE-A19

For Timer X Interrupt Service Routine

(s )
Y

Get the lower 2 bits
of digit selection
variable (MuxData).
(Only 4 digits)

Y

Switch off all the
digits

v

Send the BCD data and
digit selection data of the
currently selected digit to

port O.

v

Increment the currently
selected digit
variable.(MuxData)

Is the stop clock is Yes

in running State? ¢

Update time count for the
No stop clock

CReturn from Interrupt)

FRONTLING o
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R8C 11/13 Application Model R8C11/13-FE-A19
|

Execute Demo:

After reset, the stop clock starts showing its initial value 0000. The program will wait for start
command from the user. After the start command, the clock will start counting the time and
displayed in four digits from 0000 to 9999 seconds. When the stop button is pressed, the clock
will be stopped and the display will show the current time count. The time count will be cleared

to 0000 if the clear button is pressed when the clock is in stop condition.

FRONTLINE

www.MightyMicons.com 4 Digit Stop Clock




R8C 11/13 Application Model R8C11/13-FE-A19
|

Use Topview Simulator to Verify the Design.
Open the project Demo4 in the R8C/Tiny System Simulator using Open Project option from
Project menu. The project window opens up along with the Demod4.c file. Use Build option from

Build menu to compile the project. An output window captures the compiler ouput.

Use Project -> Download Project from main menu to download the Demo4.mot file into the
simulator’'s memory for simulation.

ANGO - RBCITiny System Simulator
File Project Memory Yiew Run Buld BreakPoint SingleStep ‘Window Help

i il P R P
— ok &

- Demo R R R A R R T R T e T e T T T T LT T e T L)
- CSourceFi\es 2 A% 4 Digite Scop Clock with Start, Stop and Clear Controls, W
3 A =
4 A% Displays a Four digit stop clock from 0000 to 9999 W
5 /7 =
B A% 4 digite of seven segment LED displays are connected in multiplexed @/
Inibsck.c 7 /%  BCD input mode. Three push button switches are connected to 3 port %/
Intprg.c 5 /% lines to have three controls start, stop and clear. W
Resetpro.c 9 J* *
REC1113_FE_A19.c 10 /* Port line Display Lines W
11 /% ——mmmmm—— e i =
12 /7 POO ECD I/P A W
13 4 FO1 ECD I/F B w
14/ POz ECD I/P C W
15/ FO3 ECD I/F D w
16 /* FO4 Digit Selection Control for digit 1 W
17 i FOS Digit Selection Control for digit 2 =
15/ FOE Digit Selection Control for digit 3 W
19 i FO7 Digit Selection Control for digit 4 =
zo /7 W
21 /* Port line Fush Button Swicthes w4
A L
23/ F3g Start Switch "
24 /7 P31 Ftop Switch W
P Clear Switch w4
|
H Output X
Load Module Converter (lmc30) for REC-Tiny,M16C-60 Series Version 4.01.01.000 -
Copyright (C) 2005. Renezas Technology Corp. T
and Renesas Solutions Corp.. A11 Rights Reserved
<¢ Conwvertion Completed »:
<< Building Completed >
oo
< k3
Ready REF21134 Mo Breakpoint Set MIC: 253430061 ©n-Chip Low Speed/&

Open the LED Module settings window and do the settings to the 7-segment LED module as
shown. Connect BCD input of the display to the port lines P00 to P03 and the 4 digit selection
lines to P04 to PO7 respectively.
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R8C 11/13 Application Model R8C11/13-FE-A19
|

LED Module Setting EJ

—LED  Seven Seament Display
Select Port Lines [ Mo Seven Segment Display
FTEE4 3210 .
Interface Select i i
i el S e ol nterface Selection Dizplay Color Data Input Display Type
Eurt‘l3 F H F F F F ™ Non-Multiplexed + Red € 7 Segment &+ Common Anode
art
Sk T + multiplexed i Green v BCD " Common Cathode
Check the checkbox to i i
Sl Multiplexer Options - Murnber of Digits:
Intemal/External Activating Level E |
0 0 2
Activating Levels * Intemal i “0 3
PEOd Pl C Estemal i 8
R EENEREEE - o
Patl FECTCTIITT 7
Pat3 T rrrr 8 b
Potd T
Check the checkboy to activate Eolllinabelceton o SIIETL
the LED at level 1 ECD P A ot lines BCD I-P & - PO_O
ECD I-F B - PO_1
EESHEE 7TEGR43210 BCD IF C - PO_2
LED Calar ECD /P D PotD & C CC OO BCD I/l_:' o - P0O_3
+ Red " Green Dot Paint Pl S SR g?tifainéel & Eg_i
Digi1 Select Poit3 O o8 cia Digit 2 Sel — P05
gt ks Potd 0 Digit 3 Sel — PO_6
Ll Digit 4 Sel — PO_7
; Fized Levels
Dlsconﬁs:;all Port 0 Lavel £ 1 Level
(1].4 | Canhcel |

Open the Keybaord Module settings window and do the settings. Connect the rows to P14 to
P17 and columns to P10 to P13.
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R8C 11/13 Application Model R8C11/13-FE-A19
|

X

Keyboard Module Setting

r keys - Toggle Type
Select Port Lines

 keys - Momentary type
Select Port Lines

FEHR 43210
[etaieiny | O
BortAa I
Part3 [ rviviv
Patd T

Activating Level:

FEBR4 3210
2o e s
ek =) O O E e 2
Fort3 [ )
Potd [T

Click the checkbox to Connect

Click the checkbox to activate the

FEH 432110
Pt I T T T
Pat1 T
Pot3 [ | _if fa I
Potd T

Cick the checkbows to Connect

a Toggle Switch

a Momentary Switch Switch at 1" level

r M atrix KeyPad

Suramary:

21
S E Fowd NG
- axe . SP ST i &

§5 RS N (e
f* Maone e

Cancel

Then open the LED window usign the option View -> External Modules -> LED as shown
below and the Program Window. Open the Keybaord window usign the option View -> External
Modules -> Keyboard as shown below and the Program Window.
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ANGO - RBCITiny System Simulator,
File Project Memory View Run Bulld BreakPoint SingleStep ‘Window Help

|7 |

- - - -
[ | #0SODH, ISP
N T T N 0C33A C7 02 DA 00 KOV B #02H, FRCR
Digitl Digi2 Digit3  Digid 0C33E 07 04 00 HOT. B #0.THD
0c341 B7 04 OO MOV B #0, PRCR
0C344 EE 30 80 00 LDC #0030H, FLG
0C348 EE 50 8D 04 LDC #048DH, 5P
2N ocaac EE 60 00 04 LDC #0400H, SB
B Matrix Keyboard and Keys [T][E]E] ncasn EE 20 00 00 DG #0000H, THTEH
Keys - Momemtary Type 0C354 EE 10 DC FE LDC #FEDCH, INTEL
0C358 FD D4 C2 00 ISR . & 0C2D4H
P3_0 ‘ P3_1 P3_2 ‘ 0C3SC FD 02 CO 00 JSR.& 0CO0ZH
0C380 F5 03 00 ISR 0C364H
0C363 FE REIT
0C364 D9 10 MOV W #1H, RO
0C366 &E FD INE 0C3R4H
0C368 Fi RTS
0C369 04 HOP
0C364A EC FD PTISH RU.R2.R3.A0.41.5B.FE
0C360 ED EF POPH RO.R1.RZ B3, A0 A1 .FB
0C36E FE REIT
0C36F 04 HOP
0C370 EC FD PUSHH RO.R2.R3, A0, 41 SE.FB
0C372 ED EF POFH RU.R1.R2.R3. 40, AL FE
0C374 FE REIT
0C375 n4 HOP
0C376 EC FD PTISHH RO.R2.R3, A0 A1 SE.FB
0C37s ED EF POPH RO.R1.R2 R340 A1 .FB
v
Executing from DC336H. .. RSFZ1134 Mo Breakpaint Set MfC 26043435 External Clockfz

Run the program using Go from the Run menu.

After reset, the stop clock starts showing its initial value 0000. The program will wait for start
command from the user. After the start command, the clock will start counting the time and
displayed in four digits from 0000 to 9999 seconds. When the stop button is pressed, the clock
will be stopped and the display will show the current time count. The time count will be cleared
to 0000 if the clear button is pressed when the clock is in stop condition.
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